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Preface

Preface

ISPSoft is Delta’s new generation software development tool for programmable logic controllers.
IEC 61131-3, which supports five programming languages and a large number of applied
instructions, is adopted. Besides, ISPSoft manages projects by means of integrating tasks. The
efficient and convenient development environment that ISPSoft provides enables users to apply
PLCs to more complex control systems as well as to small control systems.

About IEC 61131-3

In early days, PLC developers established their own programming languages. These different

programming languages were burdens on users. In view of this, IEC 61131-3, which was published

by the International Electrotechnical Commission (IEC), appeared. IEC 61131-3 integrated the

characteristics of the programming languages. It considered users’ backgrounds and users’ habits,

and defined programming language standards that manufacturers and users could follow. The

program codes which meet the IEC61131-3 standard are more readable and compatible. The

description of IEC 61131-3 is as follows.

® |[EC 61131-3 integrated the programming languages established by PLC developers, and defined
five programming languages for programmable control systems: instruction lists (ILs), structured
texts (STs), ladder diagrams (LDs), sequential function charts (SFCs), and function block
diagrams (FBDs). Besides, continuous function charts (CFCs), derived from function block
diagrams, are also a common PLC programming language.

® The concept related to symbols is adopted. Users can replace a device with a symbol. A program
is more readable, and the time of assigning devices is saved,

® The architecture related to program organization units (POUs) is adopted. A traditional program is
divided into several program organization units which can be developed independently. The
architecture of a program can be more modular and can be maintained more easily be means of
calling functions and function blocks.

® Program organization units are managed and organized through the concept related to tasks. The
development of programs is upgraded to the management of projects. The large-scale
development of programs can be managed more easily.

About the manual

The manual aims to introduce the functions of the software. The related concepts are also

introduced. The slight variations among different models which are not obstacles to the operation of

the software are mentioned briefly. Users have to refer to the related operation manuals or

programming manuals for more information.

The contents of the manual are oriented towards the introduction of the operation of the software.

Users can easily find topics related to the operation of the software in the table of contents, such as

setting communication parameters, inserting a contact in a ladder diagram, monitoring devices

online, and enabling a simulator. If the topic of a chapter is related to a certain concept, the concept

will be introduced in the front part of the chapter. Users who are equipped with basic knowledge, or

who want to know the operation of the software can skip this part, and directly refer to the related

sections. Besides, if parts of the contents of a chapter are related to the contents of other chapters,

the sections to which users have to refer will be noted in the chapter. The brief introduction of the

chapters in the manual is as follows.

® Chapter 1 and chapter 2 introduce the installation of the software, the environment, and the basic
setting.

® Chapter 3 is about configuring and setting a PLC system.

@ Chapter 4 provides a simple example, and leads users to create a traditional ladder diagram in
ISPSoft in a short time without using the IEC61131-3 architecture.

® Chapter 5~chapter 8 introduce the concepts related to IEC61131-3, and the ways in which the
concepts are applied to ISPSoft.

® Chapter 9 introduces the relative concepts of motion control and axis and the ways in which the
concepts are applied to ISPSoft.

@ Chapter 10~chapter 15 introduce ladder diagrams (LDs), function block diagrams (FBDs),
instruction lists (ILs), structured texts (STs), sequential function charts (SFCs), and continuous
function charts (CFCs) and the ways in which the concepts are applied to ISPSoft.
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® Chapter 16 introduces the auxiliary tools provided by ISPSoft.
® Chapter 17 is about monitoring a program, testing a program, and debugging a program through

ISPSoft.

® Chapter 18 introduces the password setting, and the data protection mechanism in ISPSoft.
® Chapter 19 is about configuring a network through ISPSoft, and creating a data exchange

mechanism.

® Chapter 20 is about backing up data and restoring data through ISPSoft.
® Chapter 21 introduces the tools used commonly in motion control through ISPSoft.

® Chapter 22 introduces auxiliary tools and wizards provided by ISPSoft for easier programming
and better operation.

Graphic representations

The graphic representations used in the manual are listed in the following table.

Graphic
representation

Description

Clicking the left mouse button

Clicking the right mouse button

Clicking the left mouse button two times in quick succession

Pressing and holding the left mouse button, and then moving the mouse without
releasing the button.

Typing with a keyboard

Operating sequence (The graphic representation is used when an operating

sequence is mentioned. For example, \O/ and

Number used to describe a figure

Point for attention (The item mentioned may be related to damage to equipment,
property, or a human body.)

Trademark declaration

The products and trademarks which do not belong to Delta Electronics, Inc. belong to the
companies which produce and declare them.
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1.1 Introduction of ISPSoft and System Requirements

ISPSoft is a software development tool for Delta’s new generation programmable logic controllers.
IEC 61131-3, which supports five programming languages and a large number of applied
instructions, is adopted. In addition to basic programming functions, ISPSoft also contains many
auxiliary tools. The multilingual environment and the friendly user interface provide users with a
convenient and efficient development environment.

1.1.1 Characteristics

@ |t supports the international standard IEC 61131-3 and a large number of applied instructions.

® |t supports five programming languages. They are ladder diagrams (LDs), sequential function
charts (SFCs), function block diagrams (FBDs), instruction lists (ILs), and structured texts (STs).
Users can use more than one programming language in one project.

® |t supports traditional Chinese, simplified Chinese, and English.

® The Find and Replace functions can be applied to a present window, or a whole project.
® |t provides a user-defined operating environment.

® The project management adopts an interface which uses a hierarchical tree structure.

® Users can develop several models in a group of projects.

® |t provides many convenient functions such as making comments, creating bookmarks,
activating/inactivating networks, managing devices and symbols, simulation, and etc.

@ |t supports several types of online operation such as monitoring programs online, editing
programs online, monitoring devices online, debugging programs online, operating/setting a PLC
online, and etc.

® Users can import and export projects by means of the Import and Export functions.

® Afile (*.dvp) created with WPLSoft can be opened directly, and can be converted into an ISPSoft
format (*.isp).

® |t provides several password setting mechanisms and data protection mechanisms.

® |t supports COMMGR, a new generation communication manager.

® |t supports new generation Delta AH500 series modules.

® There are three built-in configurations.
» HWCONFIG: It is used to configure hardware for a system, and manage parameters.
» NWCONFIG: It is used to configure networks for a PLC system, and manage data exchanges.

» CARD Utility: Users can backup and restore a system through a management wizard and a
memory card.

® |t provides various solutions for motion control including PLCopen MC function block, G-code
editor, E-CAM editor, positioning planning chart tool and many more.

1.1.2 System Requirements

Before using ISPSoft, users have to make sure that an operating system meets the requirements
below.

ltem System requirement
Operating ,
system Windows XP /VISTA/7/8/10

CPU Pentium 1.5 G or above

256 MB or above (A memory having a capacity of 512 MB or above is

Memor
y recommended.)

Hard disk drive Capacity : 500 MB or above

For installing ISPSoft

CD-ROM drive . . .
It is optionally required.

Resolution: 800%600 pixels or above

Monitor (Recommended setting: 1024x768/96 dpi )
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Iltem System requirement
Keyboard/Mouse | General keyboard/mouse, or device compatible with Windows
Printer Printer with a driver for Windows
(It is used to print projects, and is optionally required.)
RS-232 port For connecting to a PLC Users have to select one of them
USB port For connecting to a PLC according to the communication

interfaces provided by the PLC or the

Ethernet port

For connecting to a PLC module used. (*1)

Communication

COMMGR, a communication manager, must be installed on a computer. (*2)

software
AH500 series PLCs/DVP series PLCs (exclusive of DVP-PM series
PLCs)/VFD-C2000 series AC motor drives/VFD-C200 series AC motor
Models which drives/VFD-CP2000 series AC motor drives /VFD-E series AC motor drives

are supported

(*3)

PLC: all AH series, AS series and DVP series (except DVP-PM series)
AC motor drive: VFD series with PLC built-in

Text panel: TP series with PLC built-in

*1. ISPSoft supports several ways in which a computer is connected to a PLC. Users have to make sure of the ports
and the modes supported by a PLC before a computer is connected to the PLC.

*2. Please refer to section 1.2 for more information about COMMGR.
*3. In addition to ISPSoft, users must use PMSoft version 2.05 or above to develop AH10PM-5A and AH20MC-5A.

*4. The functions and specifications mentioned above are only applicable to ISPSoft version 2.00 or above. The
older versions may not be equipped with complete functions.

1.1.3 Installing I1SPSoft

If an older version of ISPSoft has been installed on a computer, users have to uninstall it before

installing ISPSoft. (Pleases refer to section 1.1.4 for more information about uninstalling ISPSoft.)

(1) Start a Windows 2000/NT/Me/XP/Vista/7 operating system. Users have to log on to the system
as a system administrator before they install ISPSoft.

(2) Put an ISPSoft CD in the CD-ROM drive, or download the installation program from the official
website of Delta http://www.delta.com.tw/ch/index.asp. (Before the installation program
downloaded from the website is installed, it needs to be decompressed.)

(3) Click Start, and then click Run... to open the Run window. Specify the path denoting the
executable file which is used to install COMMGR in the Open box, and then click OK.
Alternatively, users can double-click the icon which is used to install ISPSoft to execute the
installation program.

OR

QG '\@
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(4) Click Next after the InstallShield Wizard window appears.

(5) Type related information in the User Name box and the Organization box, and then click
Next.

(6) Leave the default path unchanged, or click Change... to change the path. Click Next to
proceed to the next step.

-

d@
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(7) Check the installation information, and then click Install.

i ISPSoft 2.00 - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation.

IF wou want to review or change any of vour installation settings, click Back., Click Cancel to
exit the wizard,

Curtent Settings:

Setup Type:

Destination Folder:
Ci\Program FilesiDelta Industrial AutomationiISPSoft 2.00%

User Information:
Name: User

Company: Delta TABL @

[ < Back ([ Install D[ Cancel ]
S ———”

(8) After ISPSoft is installed, shortcuts to the program will be created on the desktop and the Start
menu. Click Finish to complete the installation.

1.1.4 Uninstalling 1SPSoft

(1) There are two methods of uninstalling ISPSoft.
® Method 1: Open the Control Panel window, and click Add or Remove Programs. In the
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Currently installed programs box, click ISPSoft x.xx, and then click Remove.

O\@

® Method 2: Start>Programs>Delta Industrial Automation>PLC>ISPSoft x.xx>Uninstall

>

6

(2) After users click Yes, ISPSoft will be removed.

1.2 Introduction of COMMGR

COMMGR is a new generation communication management tool developed by Delta Electronics,
Inc. in 2011. It functions as a communication bridge between Delta software and hardware.
Communication becomes more convenient and more efficient through the management of
COMMGR.

1.2.1 Operating Mode of COMMGR

Users can create communication parameters which must be set on the management list in
COMMGR in advance. The communication parameters which have been created in advance are
called drivers. Users can start or stop a driver in COMMGR. If a driver is started, a connection will be
created automatically. After the users specify a driver which is started in ISPSoft, a communication
will be carried out.

Software Communication Port

ISPSoft

F 3
v

COMMGR

F 3
Y

COM 1

F 3
v

Hardware
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In addition to ISPSoft, other software communicating with hardware through COMMGR can operate
simultaneously. COMMGR automatically manages all communication commands, and makes
software connect to hardware.

Software 1 \ / COM 1 <+—»| Hardware 1

Software 2 |«=——| COMMGR |+— Ethernet |<«—»| Hardware 2

Software 3 / \ USB <«—>»| Hardware 3

The COMMGR window and the management list in the COMMGR window are shown below. The
drivers which are named by users are displayed in the Name column, parameters related to the
drivers are displayed in the Description column, and the statuses of the drivers are displayed in the
Status column.

A} COMMGR

Hame Description Status

(IR D B ACIL Protocol=2600,7,e,1, Retry=3, TimeOut= 3TOF
= Div_EN Ethetnet, AMD PCHET Family PCI Ethernet A dapter #2 - Pack STOP Configure
Eﬂ Drv_DL U3E Directlink U3E, Retry=3, TimeCnat=3 START
7 Drv_ DL EM  DirectLink Ethernet, AMD PCHET F amily PCI Ethernet A dapte STOP Delete
Start

1.2.2 Installing COMMGR

COMMGR is software independent of ISPSoft. It must be installed and uninstalled separately. If an

older version of COMMGR has been installed on a computer, users have to uninstall it before

installing COMMGR. (Pleases refer to section 1.2.3 for more information about uninstalling

COMMGR).

(1) Start a Windows 2000/NT/Me/XP/Vista/7 operating system. Users have to log on to the system
as a system administrator before they install COMMGR.

(2) Puta COMMGR CD in the CD-ROM drive, or download the installation program from the
official website of Delta http://www.delta.com.tw/ch/index.asp. (Before the installation program
downloaded from the website is installed, it needs to be decompressed.)
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@)

(4)

Click Start, and then click Run... to open the Run window. Specify the path denoting the

executable file which is used to install COMMGR in the Open box, and then click OK.
Alternatively, users can double-click the icon which is used to install COMMGR to execute the
installation program.

OR

g 8

Click Next after the InstallShield Wizard window appears.

InstallShield Wizard

COMMGER 1.00 Setup iz preparing the InstallShield Wizard which
will guide you through the program setup process. Please wait.

Checking Operating System Yersion

EERRERNENENERND

~
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(5) Type information in the User Name box and the Organization box, and then click Next.

5

(6) Check the installation information, and then click Install.

& COMMGR 1.00 - InstallShield Wizard

Ready to Install the Program ~

The wizard is ready to begin installation,

I wou wantk ko review ar change any of ywour installation settings, click Back. Click Cancel ko
exit the wizard.

Current Settings:

Setup Type:

Destination Folder:
C:\Program Files\Delta Industrial Autamationt COMMGRY

User Information:

Mame: User
Companty: Delka TAEL @

[ < Back q Install D[ Cancel ]
S~ __~

(7) After COMMGR is installed, a shortcut to the program will be created on the Start menu. Click
Finish to complete the installation.

d@
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1.2.3 Uninstalling COMMGR

(1) There are two methods of uninstalling COMMGR.

® Method 1: Open the Control Panel window, and click Add or Remove Programs. In the
Currently installed programs box, click COMMGR x.xx.xx, and then click
Remove.

—

® Method 2: Start>Programs>Delta Industrial
Automation>Communication>COMMGR>Uninstall

6

(2) After users click Yes, COMMGR will be removed.




Chapter 2 Starting and Setting

Table of Contents

21 Guide to Starting ISPSoft and Introduction of the Environment.......... 2-2
2.1.1 First Step of Entering ISPSOft........ccoooiiii, 2-2
2.1.2 Window Title and Status Bar ..o, 2-6
213 MENU BA..... 2-7
214 TOOIDAIS. ... 2-9
2.1.5 Project Management Area and Message Display Area .................... 2-10
2.1.6 WOrKING Ar€a.... e 2-12

2.2 Project Framework............ooovviiiiiiiiiiii 2-14
2.2.1 Single Project and Group of Projects ... 2-14
2.2.2 Integration of PMSoft into ISPSOft.........ccoooiiiiii, 2-15
2.2.3 Managing a Single Project ... 2-16
2.2.4 Managing a Group of Projects.........coooeeiiiiiiieieeeeeeeeeeeeeeeeeeeeeeeeeeeen 2-21
2.2.5 Managing a PMSoft Project through ISPSoft............ccoooeiiiiiiiiien. 2-26

2.3 Basic Setting in ISPSOft...........oooiiiiiii 2-30
2.3.1 System Setting and Environment Setting.............ccoooeeiiiiiiiiiiee. 2-30
2.3.2 Importing and Exporting Preferences...........cccoooooiiiiiiieiieeeiiieeeee 2-36

24 Communication Setting.........ccoooooeiiiii 2-37
2.4.1 Starting/Closing COMMGR .......coooiiiiii e 2-37
2.4.2 Managing DIiVEIS ......ccoooioeeeeeeeeeeeee e 2-38
2.4.3 Creating a Connection—Creating a Driver...........cooooeeiieeiiiiiieeeeee. 2-39

2.4.3.1 Setting Communication Parameters for RS232/422/485....... 2-40
2.4.3.2 Setting Communication Parameters for USB (Virtual COM)..2-41
2.4.3.3 Setting Communication Parameters for DirectLink (USB) .....2-42
2.4.3.4 Setting Communication Parameters for Ethernet .................. 2-43
2.4.3.5 Setting Communication Parameters for DirectLink (Ethernet)
........................................................................................... 2-44
2.4.3.6 Setting Communication Parameters for a DVP Simulator......2-45
2.4.3.7 Setting Communication Parameters for a AH Simulator......... 2-45
2.4.3.8 Setting Communication Parameters for a AS Simulator ........ 2-46

244  Creating a Connection—Starting/Stopping a Driver.............cccccuuueee. 2-46

245  Creating a Connection—Configuring/Deleting a Driver..................... 2-47

246  Creating a Connection Between ISPSoft and COMMGR.................. 2-48

247  Connecting a PLC and a Communication Port...............cccccuviviiinnnnee 2-50

2.4.8  Practical Connection TeSt............uuuiiiiiiiiiiiiiiiiiiiiiieieiiieeee 2-52

2-1



ISPSoft User Manual

2.1 Guide to Starting ISPSoft and Introduction of the
Environment

2.1.1 First Step of Entering I1SPSoft

After ISPSoft is installed, shortcuts to the program are created on the desktop and the Start menu.
Users can click the shortcut on the Start menu or double-click the shortcut on the desktop to start
ISPSfot. Besides, several ISPSoft windows are allowed. Users can start ISPSoft again in the same

way.

Iq@

OR

AS

After the welcome screen disappears, the Delta ISPSoft window appears. There are basic functions

available to users.

After on the toolbar is clicked, a new project is created.

s
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In the Create a New Project window, type a project name in the Project Name box and a path in
the Drive/Path box, and select a controller type and a PLC type in the Controller Type and the PLC

Type drop-down lists. After users click Properties..., they can give a description of this project.

Finally, click OK.

Create a New Project
Project Name
Controller Type AH

Diive/Path Ch

Properties..s

My Project

-

PLC Type

AHCFUS30-EN

Browser...

Cancel

=

After the project is created successfully, a project management area will appear at the left side of the
main screen. The relation between the items listed in the project management area is represented

by a hierarchical tree structure. If the project management area does not appear, users can click

Workspace on the View menu, or click on the toolbar. Besides, a message display area will

appear if users click Output Window on the View menu or click on the toolbar.
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NV

After the project is created, the main working area is blank. If users want to write a program, they
can right-click Programs in the project management area and click New....

m= Function Elloc_ —
& Device Monitor @

o J0 APls

In the Create Program window, users can type a program name in the POU Name box, and select
a programming language in the Language section. The other default values are retained, and will
be introduced in section 5.4.

Create Program E'
POU Hame rTask
Cryelic (0 -
v Active
Protection (4~12 Characters)—| rLanguage
Enter Password +! Ladder Diagram (L)
Sequential Function Chart (3FC)
. Function Block Diagram (FED
e ation Instraction List (IL)
Structure Text (3T)
PO Comment
8):4 | Cancel |

After a program organization unit is created successfully, an item will appear under Programs in the
project management area, and a program editing window will appear in the main working area.
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ing

T AHCPUS30-EN (My_Project)
B Motion Module

+- [T Tasks
EP Global Syrabols

- Proga

g Function Blocks
& Device Monditor Table
+-- T8 APls

The main screen of ISPSoft is shown below.

S
L

G—

© Window title: It displays a project name and a program title.
@ Menu bar: There are eight menus.
© Toolbar: There are five toolbars.

@ Project management area: It adopts an interface which uses a hierarchical tree structure.

© Message display area: The messages related to the compiling of a program and search for data

in a project are displayed in this area.
@ Status bar: Information about the editing of a program and connection is displayed.

@ Working area: A program editing area, a symbol table, a device table, and etc. are displayed
this area.

@ Delta Library: The contents of Delta library and user-defined library are displayed in this area.

When using ISPSoft, users can click an item on the Help menu to get help.
Help
Abont.
@) PLC Instruction and Special Registers Refarence
&P 1SPSoft User Index

in
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Item Description

Users can get the information about the version of the software,
and the date when the software is released.

Users can get the usage of the software. (Alternatively, the users
can click on the file toolbar to get the usage of the software.)

About...

ISPSoft User Index

PLC Instruction and Users can get the information about instructions and registers. If
Special Registers users click an instruction in the program editing area and press F1
Reference on the keyboard, they can get the information about the instruction.

Users can get the information about the version history of the

Version History software, and the changelog.

2.1.2 Window Title and Status Bar

After a project is created successfully, the window title displays its project name and its program ftitle.
The format is project name [program title]. If users do not set a program title, the window title will
only display a project name. Besides, if users want to view the information about a program title,
they can click Edit on the MY_Project window and select the Project Properties.

>

The status bar at the bottom of a window displays all kinds of working states, including an editing
mode (insertion/replacement), a network which is edited presently, a scan time, the size of a
program which is written/the size of a program which can be written, a connection status, the status
of a PLC, communication parameters, and a PLC model.
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PLC model —

Communication _parameters

Status of a PLC

Connection_status _l
A 4

Insert  MNetwork: 1 Sean Time: 1.200 ms 1957262128 Bteps RN Drv_SE, [USE: COM4] AHCFU530-EN

A
T__ Size of a program which is written/Size of a
program which can be written
Scan time

Network which is edited presently

. Insertion/Replacement mode

2.1.3 Menu Bar

There are eight menus in the menu bar. The items on the menus vary with editing work carried out,
and a model selected. A brief introduction of the menu bar is presented here, and a more detailed
introduction of the menu bar will be presented in the following chapters.

File Edit Wiew Compile PLC Tools Window Help

® File: It provides the function of accessing projects.
File | Edit View Compile

e ]
B Open Crl+0
Save Ctzl+S
T3] saveds Ctrbedltes
[& Close Project
& Punt Ctal+P

Project Print
& Printer Setup
1 CPRT_O.isp
2 CPRI_L isp
3 CAPRI_Zisp

Exit A+

® Edit: It provides the function of editing a project.

® View: It provides the function of viewing information about a project, and the function of setting a
work environment.
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Wiew | Compile PLC Tool Window Help

% Toohar 3
Werkspacs

Chatput Windew

Zaom 3

Momtonng Data Format  Signed Decimal =
Floating Format Setting
Used Device Feport

B @

Project Properties

® Compile: It provides the function of checking syntax, and the function of compiling a program into

an execution code.
Compile | PLC  Tools W

Check AW+FT7

=, =i

£3
i
T

Compile Ctrl+F7

® PLC: It provides the function of operating or setting a PLC through ISPSoft.

® Tools: It provides some convenient functions.
Tools | Window  Help

: H Comnomication Settings. ..
7= Changs FLC Type...
Program Settings 3
(] setrTC
\a Export 3
l-a Import »
Langnage English -
Options...

® Window: It provides the function of managing windows in the working area.
Window | Help
Caseade
Tile Vertinally
Tile Hozizontally

i
M
=
1 Progl
2 Progl

3Preg2

® Help: It provides help to users.
Help
About...
@) FPLC Instuction and Special Registers Reference

&P 1SPSoft User Index
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2.1.4 Toolbars

There are five toolbars. The icons on the toolbars also vary with editing work carried out, and a
model selected. Besides, if a mouse cursor is moved to an icon and stays there for a while, the
function represented by the icon and the shortcut to the function will be displayed. Users can select
a toolbar which they want ISPSoft to display or hide by clicking Toolbar on the View menu.

> ] - Wiew | Compile PLC Tools Wmdow Help
D 28 D= o % Toobar v [ ] stantant
Wenar (Ctel+11) Workspare FLC
Cratput Windowr Common Editor

Mopitoring Data Format  Automatically -
Floating Format Setting
@ Device Comment Used Device

® File toolbar: It provides the functions related to processing a project.
e Eg OB @&

® Editing toolbar: It provides the functions related to editing work.

® PLC toolbar: It provides the functions related to operating a PLC.

® Debugging toolbar: It provides the functions related to debugging a program. The icons on the
toolbar vary with a model selected.

AH/AS series:

DVP series:

® Programming toolbar: It provides the functions related to editing a program. The icons ton the
toolbar vary with a programming language selected.

LD: E 5B 2% At e e {l W e %4 -0
FBD: M &M 2% % it b DD 304 5 5% 1
IL: 2 Ga) % TH

ST: = IF REPEAT WHILE FOE CASE

SFC: R BRECZEEER
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2.1.5 Project Management Area and Message Display Area

The contents of the project management area are items related to project development. The project
management area adopts an interface which uses a hierarchical tree structure. The contents of the
project management area include a hardware configurator, information about devices and applied
instructions, symbols created by users, programs, tables of devices monitored, and etc. The items
listed in the project management area vary with a model selected.
The project management area appears at the left side of the main screen. If users want to close the
area, they can click in the upper right corner of the area. They can click on the toolbar, or
click Workspace on the View menu to open or close the project management area. Besides, after
users right-click an item in the project management area, a context menu will appear. The available
choices on the context menu are actions related to the item.

® AH500 Series ® DVP Series

The message display area is composed of the Compile Message page and the Find Result page.
Users can switch between the pages by clicking the tabs under the message display area. The
Compile Message page shows a result or message related to the compiling of a program or the
checking of syntax, and the Find Result page shows a result related to the search for data in a
project.

The message display area appears at the bottom of the main screen. Users can click on the

toolbar, or click Output Window on the View menu to open or close the message display area. If
users want to close the area, they can click in the upper right corner of the area.

-

PO Name Position Type Editor Language
Progh Local Bymbols LADDER
Progh Metworkl LADDER
Progl Line(l) IL

e

Compile Message( Find Result P

2-10



Chapter 2 Starting and Setting

Users can change the way in which the project management area or the message display area is
displayed by clicking [@ in the upper right corner of the area. If the icon is B, the area will be
hidden automatically. After a mouse cursor leaves the area for a while, the area will contract. If the
mouse cursor moves to the tab on the edge, the area will expand.

O <«— If amouse cursor moves to the
tab on the edge, the area will

expand.

Besides, if the area is not automatically hidden, users can drag the tab with a left mouse button to
any position, or to a position combined with the other area. If users want to drag the whole area,
they have to drag the title bar.

©-~-9\ Ii>

-
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2.1.6 Working Area

All windows are displayed in this area. If a window is maximized or minimized, it is maximized or
minimized in this area. When a window is maximized, the status buttons for the window appear at

the right side of the menu bar.
® Display of windows

® Awindow is maximized.

Users can manage windows and switch among windows through the choices on the Window

menu.
Window | Help
B Cascade
[T Tile Vertically
B Tile Horizontally

1 Prozl , : ;
2 Progl <«— Selecting an item to switch
3 Prog2 among the windows
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® Cascade: After the item is clicked, all windows will stack on top of each other, and the present
window will in the front of the screen.

B Tile Horizontally '.
1 Progl

2 Progl
3 Prog2

® Tile Vertically: Choosing Tile Vertically will cause windows to tile horizontally but take on a
vertical shape. The present window will be at the leftmost side.

Window | Help
ﬂ Cascade

[T Tile Vertically

® Tile Horizontally: Choosing Tile Horizontally will cause windows to tile vertically but take on a
horizontal shape. The present window will be the topmost window.

Window | Help
Bl Cascade

9 Tile Vertically
|E Tl Bl |
1 Progl

2 Progl

3Frog2
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2.2 Project Framework

2.2.1 Single Project and Group of Projects

There are two types of project frameworks. They are described below.

® A single project
A single project is a most basic type of project. Only one model is developed in a single project. In
other word, a single project is applied to a single model. The filename extension for a project
is .isp.

® A group of projects
If several devices are connected on a network, users can create a group of single projects for the
devices without restriction. Besides, the number of projects which can be created is unlimited.
Users can make projects according to practical application, and they can carry out network
configuration for the devices in a group of projects through NWCONFIG rapidly and easily.
The filename extension for a group of projects is .pri, and the flename extension for every project
in the group is .isp. The isp files are in the folders whose names are the same as the project
names. Besides, users can import a single project which was created previously to a group.

*. Please refer to chapter 19 for more information about NWCONFIG.
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2.2.2 Integration of PMSoft into ISPSoft

The AH500 series modules include two motion control modules. They are AH10PM-5A and
AH20MC-5A. Users can write a program for a motion control module by means of PMSoft, software
developed by Delta Electronics, Inc.. Please refer to PMSoft User Manual for more information
about usage.

PMSoft is integrated into ISPSoft. Users can create a PMSoft project in ISPSoft, and configure
hardware through HWCONFIG. Whether a project is a single project for an AH500 series module or
a project for an AH500 series module created in a group, users can create a PMSoft in the project.
The number of PMSoft projects which can be created is unlimited. However, whether a PMSoft
project is executed or not depends on hardware configuration carried out through HWCONFIG.
Please refer to section 2.2.5 for more information.

The filename extension for a PMSoft projects is .ppm. A PMSoft project and a single project in which
the PMSoft project is created are saved in the same folder. Users can import a PMSoft project which
was created previously to an ISPSoft project.

*1. To create a PMSoft project, PMSoft version 2.05 or above is used. A PMSoft project can not be created in an
ISPSoft project for a DVP series PLC.

*2. A PMSoft project which is imported must be a file created with PMSoft version 2.05 or above, and a project for a
DVP-PM series PLC is not supported.

*3. Please refer to chapter 3 for more information about HWCONFIG.
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2.2.3 Managing a Single Project

® Creating a single project
User can click the File menu, point to New, and click New to create a new project. They can also
create a new project by clicking on the toolbar.

OR @”lﬁ.l@

W\ y\e

In the Create a New Project window, type a project name in the Project Name box and a path in
the Drive/Path box, and select a controller type and a PLC type in the Controller Type and the

PLC Type drop-down lists. After users click Properties..., they can give a description of this
project. Finally, click OK.

AHCPUSIORS2
AHCEUS00-EN
AHCPUSIORS2
AHCPUSI0-EN
AHCPUS20-RE2
AHCPUS20-EN

Contraller Type AH % : US30-Rsd

Drive/Path o ﬁ
Browser...

Create a Mew Project

Project Name FI_0

AHCPUS30-EN

Cancel
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After a project is created successfully, the window title displays its project name and its program
title. The format is project name [program title]. If users do not set a program title, the window
title will only display a project name. Besides, if users want to view the information about a
program title, they can click Edit on the MY_Project window and select the Project Properties.

-

Users can see a path denoting a file and a model selected in the project management area. If a
project created is a project for an AH/AS series module, a name in parentheses will be attached to
the model selected, and the name will be the project name. The name can be changed through
HWCONFIG. Please refer to section 3.3.2.1 for more information.

1

* If aproject created is a project for an AH/AS series module, a name in parentheses will be attached to the model
selected. If a project created is a project for a DVP series PLC, no name will be attached to the model selected.
Users can identify a device by means of the name attached to it. When several devices are connected on a
network, users can check whether a device connected to the computer is the device they expect by means of
the name attached to the device.

® Saving a project
After a project is created, the file denoted by a path does not actually exist. The file will exist after
users save the file. Afile is saved in the following way.
Users can click the File menu, and click Save to save a file. They can also save a file by clicking

on the toolbar.
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If users want to save a file with a different name or want to specify a different path, they can click
Save As on the File menu, specify a new path, type a file name in the File name box, and click
Save.

Fil: = Edit Wiew Compile
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B Open Chl+ O
E% Close Project
Save Ctal+S
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Project Print
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\a Export 3
l-a Import 3
Exit AME
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*. After afile is saved with a different name, the name attached to the model selected will not change. The name
attached to the model is the project name, and can be changed through HWCONFIG.

® Opening an old project
If users want to open a project which was created previously, they can click Open on the File
menu, or click on the toolbar. After users click Open on the File menu, or click on the

toolbar, they have to select a file format in the Files of type drop-down list box in the Open
Project window, select a file they want to open, and click Open. The file formats which are
supported are as follows.

File type Description
ISPSoft files are single projects created with ISPSoft. If an old
ISPSoft Files (*.isp) file format is opened, it is automatically converted to a new file

format by ISPSoft when it is saved.

WPL files are projects created with WPLSoft. If a WPL file is
WPL Files (*.dvp) opened, it is automatically converted to an isp file by ISPSoft
when it is saved.

ISPSoft Group Files (*.pri) | ISPSoft group files are projects in a group.

*. WPLSoft is also programming software released by Delta Electronics, Inc.. Please refer to WPLSoft User
Manual for more information.
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Besides, users can select a project recently edited on the File menu.
File | Edit View Compile
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® Closing a project
After the editing of a project is complete, users can click Close Project on the File menu to close
the project. If the project has not been saved, a window inquiring whether users want to save the
project appears.
File | Edit View Compile
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Additional remark

If users do not close ISPSoft before they close a project, the project will be opened automatically
next time ISPSoft is started. (Users can decide whether a project will be automatically opened.
Please refer to section 2.3.1 for more information.)
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2.2.4 Managing a Group of Projects

® Creating a group of projects
Click the File menu, point to New, point to Group Project, and click New Group Project.

—

If users want to create a group of projects, they have to create the first single project in the group.
In the Create a New Project window, type a project name in the Project Name box and a path in
the Drive/Path box, and select a controller type and a PLC type in the Controller Type and the
PLC Type drop-down lists. After users click Properties..., they can give a description of this

project. Besides, they have to type a group name in the Group Project Name box. Finally, click
OK.

Create a New Project g|
Project Hame PI_0
Cottroller Type AH hd PLC Type AHCPUS30-EN -